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Learning Objectives
•
•
•
•

Create simulation ready geometry in the Fusion 360 Simplify Space
Understand and implement electronics cooling best practices
Post process simulation results and verify design criteria
Leverage Modify/Update geometry via Fusion CFD CAD Connection

Description
Engineers and designers are constantly pressed to deliver greater performance while
simultaneously cutting costs and using up less space. This phenomenon requires many design
revisions and the designer and engineer must work together to arrive at the best possible
solution which meets the design criteria. This class will start by demonstrating how to create
simulation-ready geometry within the Fusion 360 Simplify workspace. Iterating between Fusion
360 and Autodesk CFD seamlessly, this class will dive into setting up rapidly prototyped
electronics board configurations and evaluating its thermal performance. Stepping through
electronics cooling best practices, post-processing simulation results, and evaluating multiple
designs - you will learn not only how to validate the original design, but also how to innovate and
land on the best possible design. You will learn the effectiveness of iteration CAD modifications,
up-front simulation, and master rapid prototyping workflows.
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Speaker(s)
About the Author: Matt Bemis is a CFD technical support specialist and
CFD Knowledge Domain Expert at Autodesk, responsible for providing
customer support in the Americas. Matt spends his days interacting with
end users and helping them solve their engineering problems by best
leveraging CFD. He is well versed in modeling electronics cooling,
turbomachinery, external aerodynamics, automotive, and biomedical
applications. Before joining Autodesk, Matt did product support and
consulting for an application specific CFD tool which models airflow and
cooling inside of data centers.

About the Co-Speaker: Technical Support Specialist and Knowledge
Domain Expert at Autodesk supporting Fusion 360 with a background in
Mechanical Engineering and FEA. This is his second AU class utilizing
simulation and Fusion 360 on electronic devices. Currently taking an
interest learning and supporting Generative Design technologies, and
learning and help provide workflows for new, innovative consumers in
the manufacturing world.
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Create simulation ready geometry in the Fusion 360
Simplify Space
•
•
•
•
•

What is simulation-ready geometry?
What’s important, what’s not
Fusion 360 Simplify Workspace
Defeaturing
Defining air volumes and bounding box

Simulation ready geometry
An effective CFD simulation starts with good CAD techniques, both in terms of model integrity
and proper creation of the flow region. Once obtaining a manufacture-ready CAD, it is
necessary to vastly simplify the geometry to simulate it efficiently in CFD. Skipping this step will
make the simulation process painful, slow going, and tedious. Production level geometry can
contain gaps, interferences, bolts, rivets, threads, part names, chamfers, and fillets. Failure to
remove these features will result in meshing errors and failure, as well as contributing to higher
overall element counts.

What’s important, what’s not
The question of what to remove and what not is always a common concern or topic for new
users. Generally, all parts that do not critically affect the flow/heat transfer should be simplified
or removed completely. It is much easier to get a working model and then decide what geometry
to add back into the simulation.
•
•
•
•
•
•
•
•
•
•
•

The following should always be removed/filled:
Fillets with small radius
Chamfers
Gaps that do not have a significant impact on flow
Fasteners
Sheet metal parts
Perforated mediums
Grates
Vents
Filters
Sponge materials
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Fusion 360 Simplify Workspace
Fusion 360 has a Simplify workspace within the Simulation environment that allows a user to
defeature and edit geometry without making permanent changes to the manufacture-ready CAD
in the Model workspace. To enter the Simplify workspace, enter Simulation, and then select
“Simplify”.
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Defeaturing
Once in the Simplify workspace, you will see your geometry as it looks in the Model space, with
no changes to the CAD model. The ribbon will consist of a mix between Model space toolsets
and tailored geometry modification tools.

The “Modify” drop-down has an array of functions, including some new features like:
•
•
•

Remove Features
Remove Faces
Replace with Primitives
1. Start by right-clicking on the “Machined Base” component and select Remove.
2. Continue to do the same with the “Sheet Metal Cap”, “Screens”, “Battery Holder”,
“Switch” and “Hardware” components.
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NOTICE A TRANSPARENT RECTANGULAR BODY IS IN LOCATION OF THE SELECTED BODY. T HERE ARE ARROWS
WHICH ALLOW YOU TO PUSH/PULL CERTAIN FACES AS DESIRED.

3. From the Modify menu, select “Replace with Primitives” and select the LCD screen. A
shadowed shape covering the outer dimensions of the screen will appear.
4. Select OK and a new rectangular body will be created.

NOTICE THE LCD SCREEN (PART: LDQ-M3604RL:LED1) IS REPLACED WITH A SOLID BODY
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5. Continue to do this on the CMOS chip (Part: N20:IC3), Molex 4 pin connector
(1X04:JP1), and 2 pin connector (Part: 1X02:JP2).

THE REPLACE WITH PRIMITIVES OBJECT SHAPE CAN BE CHANGED. IN THIS CASE, IT SHOULD BE CHANGED FROM
BOX TO CYLINDER.

THE ABOVE CYLINDER MAY RESULT IN A MESHING ERROR DUE TO THE TANGENT POINT BETWEEN THE CYLINDER
AND THE HEAT SINK WALL.
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Some features need to be removed via a more traditional/manual process. In the above image,
there is an unnecessary cylinder which may result in meshing issues, and therefore should be
removed.

EXTRUDE CUT THROUGH THE ENTIRE PCB BOARD.

1. From the Create menu in the ribbon, select Extrude and select the
top face of the cylinder.
2. Left click to select the blue arrow, and pull it down through all
geometry. The Operation will switch from New Body to Cut.
3. Select OK.
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SELECT THE FACE OF THE HOLE AND PRESS DELETE.

Next, the hole in the PCB board must be filled.

1. Left click on the inner surface of the hole.
2. Press the Delete key on your keyboard. This will automatically remove the hole and heal
the geometry.

THE HOLE WAS FILLED AND THE GEOMETRY IS HEALED.
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3. Notice the hole is filled and the geometry is smooth. There are no split faces or bodies.

THERE ARE SEVERAL OTHER HOLES EXIST IN THE PCB BOARD. CONTINUE TO REMOVE THESE HOLES BY USING
THE DELETE KEY.

4. Continue to remove other holes via the Delete key.
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Next, the Remove Features function will be used to remove electronic chip pins.

THE REMOVE FEATURES TOOL WILL BE USED TO REMOVE PINS BETWEEN THE CHIPS AND BOARD.

1. In the Modify drop down, select Remove Features.
2. Uncheck the Select All box, and select Holes under Features.
3. In the upper left corner of the model space, left click and start to drag your mouse to the
bottom right of the space.
4. A select box will appear. Size the selection box appropriately to select all parts of the
electronics board.
5. Click and drag the Feature Size slider and watch to see what geometry becomes
selected/deselected. The highlighted geometry will be deleted. Set the slider bar so all
pins will be deleted, but critical geometry will not be removed.
6. Press Delete and wait for the pins to be removed and the geometry be healed.
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USE REPLACE WITH PRIMITIVES TO SIMPLIFY THIS UNNECESSARY CONNECTOR.

The defeaturing and necessary modifications to the board are now done.

THE BOARD IS NOW DEFEATURED AND CONSIDERED SIMULATION READY.
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Defining air volumes and bounding box
Now that the electronics board is fully defeatured and ready for simulation, it is time to define
the bounding box. This will be a natural convection CFD analysis. Hot parts cause the adjacent
air to warm up, resulting in a decrease in density. The air will start to rise from the board and
continue upwards.
The board will be modeled in CFD as if it is resting on a platform or table. The setup used is
sometimes referred to the “bucket” configuration.

THE FOLLOWING GUIDELINES CAN BE USED TO SIZE A BOUNDING BOX AIR VOLUME.

An air volume, referred to as a bounding box, needs to be constructed around the device. The
bounding box can be sized by using the above equation. The board dimensions are
approximately 4.45” x 2.25” x 2.55”. Using the above equation, in this model, D = 3.5 inches. A
24” x 24” x 24” bounding box will be created, with about 0.5” of space underneath the
electronics board. More information pertaining to natural convection analysis and sizing
bounding boxes can be found in the online help documentation.
Before building the final bounding box, it is advantageous to build several separate CAD bodies
around and above the heat sink. This will allow better mesh control once in Autodesk CFD.
1. While in the Model space of Fusion 360, select the Sketch Drop down in the ribbon and
select 2-Point Rectangle.
2. Press the Top selection of the View Cube. Next, start the rectangle by selecting a point
on the board in the upper left corner of the heat sink.
3. Drag your cursor to the bottom right to finish the rectangle. Make sure the rectangle
encompasses the entire heat sink, with plenty of room on all sides.
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YOUR RECTANGULAR SKETCH SHOULD BE LARGE ENOUGH TO ENCOMPRESS THE ENTIRE HEAT SINK.

ONCE YOU ARE SATISFIED WITH YOUR RECTANGULAR SKETCH, SELECT STOP SKETCH.
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4. Select Stop Sketch.
5. Select the Create drop down and click on Extrude. Extrude the rectangle 2.7” upwards.
Select New Body as the operation, and select OK.

MAKE SURE TO CHANGE THE OPERATION TO NEW BODY.
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THIS CROSS-SECTIONAL VIEW SHOWS THERE IS ADEQUATE SPACE BETWEEN THE TOP OF THE HEAT SINK AND THE
NEW VOLUME.

Notice there is a large gap between the top of the heat sink and the solid body. This allows
sufficient mesh between the top of the heat sink and new CAD volume. Without this space, the
elements will become skewed and the nodal aspect ratio will be large, which is undesirable.
This new CAD volume will be assign as air during the CFD setup. During the meshing stage,
this volume will be selected and the mesh density will be increased. It is critical to have a high
number of mesh elements surrounding the heat sink as it will accurately capture the convection
heat transfer from the metal wall out into the air domain.
Next, another body will be added above the heat sink which extends to the top of the bounding
box. This will be used to add more mesh density in the velocity plume above heat sink.
1.
2.
3.
4.
5.

From the top ribbon in Fusion 360, select the “Sketch” drop down and “Create Sketch”.
Click on the top face of the heat sink air volume.
From the Sketch drop-down, select Center Rectangle.
Type in 5”, then press tab to toggle to the next dimension, and enter 4.5”.
Select Stop Sketch.
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6. From the Create drop down, select Extrude and Within the Extrude dialog box, select
New Body, instead of the default Join operation.

ONCE THE CENTER RECTANGLE IS DRAWN, SELECT STOP SKETCH.

7. Select the Sketch Profile and input a length of 20.638 inches.
8. Set the operation to New Body, and press OK

9.
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Your geometry should now look like the above image. Lastly, we will add the 24” x 24” x 24”
bounding box which encloses all the current geometry.
1.
2.
3.
4.

In the Construct drop-down menu, select Offset plane.
Select the bottom face of the electronics board. A plane will appear.
Use the dialog box to move the plane 0.5” downwards in the Z direction. Select OK.
In the Fusion 360 ribbon, select Sketch> Center Rectangle. Click on the offset plane
previously defined.
5. Click the origin to define the center of your rectangle.
6. Enter 24” as a side dimension, then select tab to toggle to the perpendicular side. Again
enter 24”.
7. Select Stop sketch.

THE BOUNDING BOX WILL BE 24" X 24" AND CENTERED AT THE ORIGIN.

1. From the Create menu, select Extrude.
2. Select the sketch and extrude upwards 24”. Set the Operation to New Body.
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THE BOUNDING BOX WILL BE 24" X 24" X 24".

You are now done preparing your geometry and can launch the CAD to Autodesk CFD 2019.

LAUNCH THE PROJECT TO AUTODESK CFD VIA THE CAD CONNECTION IN THE SIMPLIFY WORKSPACE.

Using the CAD connection available in the Simplify workspace, launch a new CFD project.
Select the save location on your local computer. Make sure the location is a local drive, and is
not a folder that is synced with a cloud storage service (OneDrive, Box, Google Drive, etc).
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Understand and implement electronics cooling best
practices
Now that a new Autodesk CFD project has been created, it is time to setup the model.

THE AUTODESK CFD USER INTERFACE IS LAID OUT IN A USER-FRIENDLY, INTUITIVE MANNER.

The Autodesk CFD user interface is laid out in a user-friendly manner. You can do just about
everything with the ribbon commands. Alternatively, all workflows are also accessible via the
Design Study Bar, which is located on the left side of the screen. The Setup ribbon is arranged
in a left-to-right workflow. You will start by assigning materials and finish by hitting solve.
General note on navigation: Left-click to select the volumes. Use Control + Mouse Wheel button
to hide bodies. Refer to the Autodesk CFD Model Navigation help documentation for further
information.

Setup
Start by assigning air to the 3 CAD volumes that were created in the Fusion Simplify space.
1. Left click to select the heat sink air body, the flow plume body, and the large external
bounding box.
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SELECT THE 3 AIR VOLUMES, AND THEN SELECT EDIT TO APPLY A MATERIAL.

2. In the Setup ribbon, click on “Edit”. A dialog box will appear.

ONCE AIR IS SELECT AS THE MATERIAL, NAVIGATE TO ENVIRONMENT TO SET THE MATERIAL PROPERTIES TO
VARIABLE.
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3. Make sure the Material DB Name is set to Default and Type is Fluid. Select the Name
drop down and set it to Air.
4. With the Material dialog box still up, select “Environment”.

SETTING THE MATERIAL ENVIRONMENT TO VARIABLE ALLOWS THE DENSITY OF AIR TO CHANGE AS A FUNCTION OF
TEMPERATURE.

5. Set the Material Environment to Variable. This will allow the density of the air to fluctuate
based on local temperatures. This is necessary and critical for natural convection;
without this there will be no buoyancy and therefore no flow.
6. Select OK, and then Apply on the material assignment.
Now that the air volumes are defined, they can now be hidden.
7. With the mouse hovering over an air volume, select Control + Mouse wheel button. The
volume the mouse is on will be hidden. Continue to do this for all air volumes.

Next, the heat sink and PCB board will be assigned materials.

1. Left click to select the heat sink body.
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ASSIGN THE HEAT SINK AS COPPER.

2.
3.
4.
5.

Select Edit from the ribbon.
Set the Type to Solid, and Name to Copper. Select Apply.
Left click to select the electronics board body.
Select Edit from the ribbon, and navigate to the Printed Circuit Board material in the
Default material database. Unlike before, use the Printed Circuit Boards Type, instead of
Solid.

APPLY THE DEFAULT PCB MATERIAL TO THE ELECTRONICS BOARD.

6. Select Apply.
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Next, assign the aluminum bodies.
1.
2.
3.
4.

Left click to select the chip pins which are located between the heat sink.
Select the cylinders (simplified knob bodies).
Select Edit in the ribbon, make sure the Type is set to Solid.
Select Apply to assign default Aluminum to the highlighted volumes.

Lastly, all the electronic chip bodies need to be assigned silicon.
1. Left click to select all the remaining unassigned bodies.
2. Select “Edit” in the ribbon.
3. Change the material Type to Solid, and Name to Silicon.

SELECT THE REMAINING UNASSIGNED BODIES AND SET THEIR MATERIAL AS SILICON.

4. Select Apply.
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1Now that all materials have been applied, the model should look like the image above.

Boundary Conditions
Select the ‘Boundary Conditions” tab. The external natural convection boundary condition setup
used in this setup is sometimes referred to as the “bucket” approach, and mimics the thermal
performance of the board as it is sitting on a table in ambient temperature. First, boundary
conditions will be applied to the external bounding box.

1. In the top ribbon, select Boundary Conditions to begin assigning boundary conditions.
2. Left click to select the top surfaces of the air volume.
3. Select Edit, and set the Type to Pressure, Unit to Pa, and Value to 0 to set a 0 pressure
boundary condition on the selected surfaces. Select Apply.
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APPLY A 0 PRESSURE GAGE BOUNDARY CONDITION TO THE TOP SURFACES OF THE DOMAIN.

1. Left click to select the same top surfaces and select Edit again. You will notice the 0
pressure boundary condition appears.
2. Change the Type to Film Coefficient. Set the value to 2 Watts/m2*K with a reference
temperature of 70 degrees F.
3. Left click to select all 4 side faces of the outer bounding box. Select Edit. Change the
Type of Boundary Condition to Temperature. Set the temperature to 70 degrees F.
Select Apply. This simulation will consider radiation heat transfer, so all external
surfaces need to have a thermal boundary condition.
Finally, hide the air volumes so the electronics can be viewed. In the ribbon, change the
selection option from Surface to Volume. This will change the boundary condition types and
allow for heat generation boundary conditions on volumes.

1. Left click to select the highlighted chip below. Select Edit.
2. Enter a 10 Watt Total Heat Generation value. Select Apply.
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Next, several more total heat generation boundary conditions will be applied. Use the same
steps as above to apply a 2 Watt, 1 Watt, and 0.5 Watt total heat generation boundary
conditions to the below parts. It is expected that these heat loads will have m arginal effect on
board temperature. At this point all boundary conditions are set.

THE FINAL TOTAL HEAT GENERATION BOUNDARY CONDITIONS ARE 2, 1, AND 0.5 WATTS.

Meshing
Prior to running an Autodesk CFD analysis, the geometry is broken up into small pieces called
elements. The corner of each element is a node. The calculation is performed at the nodes.
These elements and nodes make up the mesh. Autodesk CFD performs a comprehensive
topological interrogation of the analysis geometry and determines the mesh size and distribution
on every edge, surface, and volume in the model. Geometric curvature, gradients, and proximity
to neighboring geometry are all considered when assigning element sizes and mesh
distributions.
Automatic meshing will be used in this analysis. To access the meshing tools, click the Setup
tab and then Mesh Sizing. By default, Automatic meshing will be selected. Select Autosize. The
geometry will now have a basic, automatic mesh applied. The mesh seeds and spacing indicate
the mesh density once the mesh is generated.
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SELECT MESHING SIZING IN THE RIBBON AND THEN PRESS THE AUTOSIZE BUTTON.

THE MESH SEED POINTS ABOVE REPRESENT THE INITIAL MESH SIZING.

The mesh around the heat sink and plume will be significantly increased in density as that is
where the dominate flow and heat transfer will occur.
1. Left click to select the air volume around the heat sink.
2. Select Edit in the ribbon, which will open the meshing sizing dialog box.
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3. Move the slider bar to 0.8, Select Apply, and Spread Changes.
4. Select Apply.
Increase the mesh density of the plume air volume by following the same steps and adjusting
the slider bar to 0.6.

REFINE THE MESH IN THE PLUME MY SELECTING THE VOLUME AND MOVING THE SLIDER BAR TO 0.6.
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Finally, more mesh will be added to the top surface of the domain. This face will have flow
entering and exiting, so it is important to have a high quality mesh.
1. In the Setup tab, change the part selection to Face. Select the top two faces of the
domain.
2. Select Edit to open the mesh dialog box.
3. Move the slider to 0.6 and select Apply and Spread changes.
4. Check Surface refinement and Gap refinement, and select Refine.
5. Select Apply.
6. Run the simulation for 0 iterations to confirm the model meshes without issue.

ABOVE IS AN IMAGE OF THE FINAL MESHED DOMAIN.

The resulting mesh has 4,388,685 total elements, with 3,280,132 fluid elements, and 1,108,553
solid elements.
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Solver settings
Now the simulation is ready to be run. Several solver settings must be specified before selecting
Solve.
1. Select the Solve button, which is located in the ribbon.
2. Within the Solve dialog box, set the simulation to run for 1000 iterations. The simulation
will likely converge before this, and the solve will automatically stop early when
convergence is detected.
3. Select the Physics tab, and check the Heat Transfer and Radiation boxes to enable
these physics.
4. Specify the gravity direction as 0,0,-1.
5. Select Solve, and the simulation will begin to run.

Post processing
Once the simulation has converged, the solver will automatically stop iteration. A message
stating “Convergence detected. Auto-stop” will appear in the Output Bar and the Global Results
will be showing velocity.

GLOBAL VELOCITY MAGNITUDE RESULTS WILL APPEAR WHEN THE SIMULATION HAS CONVERGED.

The area of interest for the electronics board is the highest temperature in the domain and the
chip temperature where the 10 Watt heat load was applied. The Parts Calculator will be used to
probe the average temperature of the chip.
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1. Hide the air volumes by using Crtl + middle mouse button.
2. Zoom via the mouse scroll wheel to take a close look at the IC chip.

SET THE GLOBAL RESULT TO TEMPERATURE.

3. Set the Global Result to temperature via the drop down menu in the ribbon.
4. In the ribbon, select the Parts calculator and click to select the IC chip.
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SELECT THE IC CHIP. THE AVERAGE TEMPERATURE IS 74.6 DEGREES CELSIUS.

5. Observe the average temperature is 74.6 Celsius. Select the check box.
6. In the Design Study Bar, select Design 1, Right Click and Clone.

CLONE THE DESIGN STUDY AND MAKE SURE TO INCLUDE MESH AND RESULTS.

7. Name the new Design New Heat Sink Geometry and check the box to include mesh and
results.
8. Select OK.
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Leverage Modify/Update geometry via Fusion CFD
CAD Connection
Now that results have been obtained for the initial design, a different heat sink will be tested to
verify it allows for better cooling. Start by opening the “New Heat Sink” f3d file and enter the
Simplify workspace. Instead of launching a new Autodesk CFD project and manually going
through the setup process again, an Update Geometry feature will be used to intelligently
change the geometry and reassign material definitions, boundary conditions, and meshing
settings.
1. Select the Autodesk CFD CAD connection via the Simplify Workspace and click
“Simulate in CFD”.

SELECT THE UPDATE DESIGN STUDY TAB.

2.
3.
4.
5.

Select the Update design study tab.
Navigate to the name of your CFD project, and select the down arrow to expand.
Click to select the new Design, New Heat Sink Geometry”.
Select Update design.

The new geometry has been imported and the material assignments, boundary conditions,
and mesh settings have been transferred over.
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THE NEW GEOMETRY HAS ALL MATERIAL ASSIGNMENTS ASSIGNED AUTOMATICALLY.

Rerun the simulation from 0 iterations. Observe the IC chip temperature via the Parts calculator.

THE AVERAGE CHIP TEMPERATURE WITH THE NEW HEAT SINK IS 64 DEGREES CELSIUS.
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The average temperature of the IC chip is 64 degrees Celsius.

Using the Decision Center
While viewing the global temperature results, it can be very useful to have a side-by-side
comparison. The Decision Center allows this type of comparison.
1. While viewing global temperature results, click to select “Summary Image” in the top left
corner of the ribbon.
2. Select the Decision Center tab in the ribbon.
3. In the Design Study Bar, right click on Image 01 and Update image.
4. Notice there is now a side-by-side comparison of the two different designs.

THE DECISION CENTER ALLOWS FOR SIDE-BY-SIDE COMPARISONS OF DIFFERENT GEOMETRY.

The New Heat Sink design allows the heat sink chip to operate at about 10 degrees cooling. A
performance decision can now be made as to which heat sink is better for this electronics
assembly.
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